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The fourth issue of the DMFAS Newsletter brings
you a range of articles covering different aspects of
debt management. Among others, these include the
development of version 5 of the DMFAS (SAGE),
activities of UNCTAD and the World Bank under
the Joint Programme, the Technical Focus, and a
request for information on analysing debt statistics.
We hope you enjoy it. As always, any suggestions
or comments from our readers are very welcome.

The systems analysis stage for the development of
DMFAS Version 5 (SAGE) was completed in April
1993, To wrap up this stage (as at the end of each
stage of the system development) a quality
assurance review was held, at which the results of
the analysis stage were reviewed. The review was
attended by the World Bank, selected DMFAS
vsers, and a debt manager from Morocco. Of
particular interest to the reviewers was the way in
which the new system will handle disbursements
and debt service. The design stage has now been
initiated.
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World Bank/UNCTAD
Joint Programme activities

The World Bank participated in the quality
assurance review which wrapped up the systems
analysis stage in the development of DMFAS
Version 5. Other joint activities included a meeting
of the Steering Committee in February (at which
UNDP, UNCTAD and the World Bank monitor the
development of the Joint Programme between
UNCTAD and the World Bank), and a joint needs
agsessment mission to Argentina in March 1993,

During the first half of this year, significant
progress has been made in the further development
and implementation of the so-called Regional
Capacity Building Initiative in Debt and Reserves
Management for Anglophone countries of Southern
and Eastern Africa, sponsored by the World Bank
and UNDP.

A Workshop was held at Kadoma, Zimbabwe from
February 21 to 26, 1993 with representatives of 26
Ministries of Finance and Central Banks from 11
countries. The major objective of the workshop was
to undertake an assessment of capacity building
requirements in debt management and how to
address them. A final regional project proposal will
be presented to the Steering Group of the Initiative,
composed of Central Bank Governors and
Permanent/Principal Secretaries of Ministries of
Finance of the region, and to cooperating partners
at a meeting scheduled in June.

UNCTAD will continue to support this initiative,
which is sponsored by the World Bank and UNDP
within the framework of the Joint Programme of
these three agencies. It is hoped that funding will be
made available by multilateral and bilateral donors
so that UNCTAD as well as other providers of
technical cooperation services, can supply the
required products and services.

This initiative is the first regional undertaking
within the framework of the Joint Programme.
Other regional programmes are scheduled for West
Africa, Central America and the CIS-countries.
They will support the use of computer-based debt
management systems, such as the DMFAS, provide
training and advisory services in debt management,
and promote networking among debt managers in
the region concerned.

SEMINAR NEWS
Seminar on debt management in Damascuos

In April 1993, an UNCTAD representative attended
a seminar on debt management, which was jointly
organised by the Islamic Research and Training
Institute of the Islamic Development Bank
(IRTI/ISDB), the Syrian Ministry of Finance and
Foreign Trade and the Syrian Central Bank. It was
attended by senior officials dealing with external
debt in several Arab countries. The Cabinet
Information and Decision Support Center (IDSC)
from Egypt also assisted in organising the seminar.
Lectures covered the causes and concept of external
borrowing, the institutional framework for external
debt management, the effect of debt on investment
and the relation between exchz{hgc rate fluctuations
and debt, debt monitoring systems, and methods of
debt management and borrowing strategy and debt
projection. The UNCTAD representative delivered
a lecture on effective debt management and made
a brief demonstration of the DMFAS, in particular
the DMS.

The Islamic Development Bank is planning to offer
a seminar on debt management in the second half
of 1993.

UNCTAD co-sponsors regional seminar on
debt conversion in Tegucigalpa, Honduras

The first regional seminar on debt conversion was
convened in Tegucigalpa, Honduras from 19 to 21
May 1993. It was organised by UNCTAD, SELA
and UNDP, and was hosted by the Government of
Honduras. The seminar was attended by 45
participants from 22 Latin American and Caribbean
countries, representing for the most part senior
policy makers from Central Banks. Some eleven
International and regiomnal institutions, including
NGOs and one creditor country, also attended.

The seminar was dedicated to the examination of
couniry experiences with commercial and official
debt conversions, and ways and means to encourage
such deals, especially with regard to official
bilateral debt. An important outcome was an offer
by the Government of Ecuador to host a high-level
consultative meeting between Paris Club creditors
and Latin American debtor countries in November
1993, in Quito. '




TECHNICAL FOCUS

1. DMFAS 4.1PLUS UNDER WINDOWS 3.1

Although the DMFAS 4.1Plus is not a Windows
program, it is possible to run it in a DOS window
under Windows. You will not be able to use a
mouse in the DMFAS program, but you can easily
switch between DMFAS and Windows programs.
To do this, you have to make two changes, because
1) Windows has its own environment space and 2)
the PIB (that sets the environment variables} . will
not run correctly under Windows. Use SPFPC or
another editor to change/create the files mentioned
below.

1} Increase Windows’ DOS environment space
In your CONFIG.SYS line you will see the
following line (the number after E: may vary):
SHELL=CADOS\COMMAND.COM /E:3072 /P

This line increases the DOS envircnment to 3072
bytes (characters), and is necessary to make enough
space for the variables created by the PIB program.
But since Windows has its own environment, you
will also have to Increase the Windows’' DOS
environment. This can be done by inserting the
following line in the [NonWindowsApp] section in
the SYSTEM.INI file found in the Windows
directory (if a [NonWindowsApp] section does not
exist, you will also have to type that line). The
change will take effect after restarting Windows.

[NenWindowsApp]
CommandEnvSize=3072

2) Run PIB before starting Windows

Since the PIB.EXE file does not work correctly
when run under Windows, the easiest way to get
around this problem is to run PIB before entering
‘Windows. This can be done by typing PIB C: A:
before entering Windows, or by creating the

following WIN.BAT file that does it:
CABATFILESYPIB C: A:

CAWINDOWS\WIN

CABATFILES\PIBOFF

It is jmportant that this batch-file is placed in a
directory that appears before the Windows
directory in the PATH to avoid the WIN.COM file
being executed instead of your WIN.BAT file
{check your AUTOEXEC BAT file to see the order
of directories in your PATH line). Now all you
have to do is to install an icon for the DMFAS
program in the Program Manager. This can either
be done by having Program Manager and File
Manager side by side, and dragging the DM.BAT
file into Program Manager, or by choosing New and
Program Ttem from the File menu in Program

Manager (see your Windows manual for further
explanation).

NB! When your uge the Print Screen key under Windows, the
screen will be copied to the Windows clipboard file instead of
being sent to the printer as under DOS. If yon want to do a Print
Screen when you run DMFAS under Windows, press Print
Screen, enter a Windows program {e.g. Write), choose Paste
from the Edit menu to paste your screen into a document and
choose Print from the File menu to print it to a printer.

2. VIRUSES

In the last seven months we have found PC viruses
on PCs or diskettes in five countries, and we have
therefore included a section about PC virnses in
the newsletter. A PC virus is a small program with
certain features;

1) All viruses have the ability to reproduce
themselves automatically. When you run a program
with a virus, the virus can copy itself to another
program (e.g. a word processor). You also have
viruses that do not infect programs, but stay in the
boot sector on a diskette or a hard disk. This type
of virus can infect your hard disk from a diskette as
soon as you access the diskette, for example by
typing DIR A:.

2) While some viruses are ‘"satisfied" with
reproducing themselves without doing much harm,
other viruses have "missions” which make them
dangerous. These missions can be quite harmless,
such as, for example, "playing a Christmas song if
the program containing the virus is started on the
25 of December", but also destructive such as
"deleting one random selected file on the hard disk"
or even "destroy the contents of the boot sector" so
vou will not be able to access your data at all.

There are several ways to prevent virus attacks.
Some good rules are: Always write-protect your
originals; never leave a diskette in your A: drive
when you (re)start your PC; do not use diskettes
which you have "borrowed" and avoid using the
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same diskettes on different PCs without checking
them first.

The best way of preventing virus attacks is to
always vse originals. Use virus protection programs
for finding and removing viruses. One way of
protecting your PC is to have a resident virus
detector, This detector could be loaded from the
AUTOEXEC.BAT file, and therefore be active all
the time the PC is on. The detector wonld
automatically check the diskettes and programs
accessed during a PC session. Another possibility
is having some sort of a virus scanner, that goes
through all the files on a directory, hard disk or
diskette. This program carries out more thorough
checks, but it may take a long time to run, and does
not check for viruses in the background as a
resident virus detector does. Some of the scanning
programs also remove viruses, while others only tell
where and what kind of virus it finds. In the last
case, you will also need a program that removes the
virus,

On the DMCONFIG diskette that we have sent to
all our users, there is a virus directory where you
will find virus programs, documentation and
description of different viruses. This programs are
shareware programs, so if you find them vseful and
want to install them, you should pay a fee to
McAfee Associates in USA.

3. DMCONFIG, CHECKS THE PC
CONFIGURATIOCN AND VIRUSES

With the DMFAS update no 1, 1 March, we also
sent the DMCONFIG diskette. We will again
remind you that this is a very useful tool for
checking the PC. If problems occur, run the
DMCONFIG program from this diskette, and print
the report. From this report you might find the
problem yourself, or you could fax it to us for
consultation. Run this program regularly to check
your PCs for virnses.

4. DOS 6.0

In April 1993, Microsoft released its new version of
DOS, Here is a list of some of the features in the
new version.

Disk Doubling

With a compression technique uvsers will have an
option of virtually doubling their hard disk space.
This is done by antomatically compressing all files
saved on the hard disk. How much more disk space
you gain, depends on what kind of files you have
on your hard disk. Data files (like GDB and FDB
files) will be compressed to about one fifth of
original size, while the DB???.EXE files is
compressed to about 75% of their original sizes.
NB! some programs (like Norton utilities} are not
yet compatible with this disk doubling feature and
may corrupt files.

Back-up program

Microsoft has a licence agreement with Symantec
to include a subset of its backup program in its new
version. Features like compression of data and
backup of changed files are included.

Disk defragmentation
Microsoft also has a licence agreement with
Symantec to include a version of its compress-
program in version 6.0.

Virns protection

There is also a virus protection program (a subset
of Central Point antivirus program) with the new
version of DOS. As new viruses are discovered, it
will be possible to upgrade the virus protection
program to search and remove them.

Memory management

MEMMAKER is a program that automatically sets
up your AUTOEXEC BAT file and CONFIG.SYS
file to gain as much conventional memory as
possible.

New commands

Several commands have been improved, and a few
commands have been added. With DELTREE you
can delete a directory tree with several
subdirectories and files with one command. With
MOVE vyou can move files from one directory to
another.




5. MEMORY MANAGEMENT (DOS 5.0}

" Even if your PC has several Mbs of memory, most

DOS programs will only be able to use the first
640 kilo bytes (the so-called conventional memory).
To run all the modules of DMFAS version 4. 1Plus
you need 574 Kb of free conventional memory, and
it is sometimes tricky to set up the computer the
right way to obtain that. However, if you have a
286 PC or better with more than 1 Mb of memory
and DOS 5.0 (or newer), there are ways of moving
some resident programs from the conventional to
the upper memory area (between 640 Kb and 1024
Kb) and the high memory area (between 1024 Kb
and 1088 Kb), and that way create more free
conventional memory for DOS programs. To find
out how much memory you have, type the DOS
command MEM.

Tuning your memory is done by changing the
AUTQEXEC.BAT apd CONFIG.SYS files as
described below. Before you start, create a
bootable diskette (insert an empty diskette in your
A: drive and format it with FORMAT A: /§) and
copy your old AUTOEXEC.BAT and CONFIG.

SYS fiies to a diskette in case you make a mistake

during the memory "tuning”.

Insert the following lines on the top of your

CONFIG.8YS file to load the COMMAND.COM Conventional metmory {

to the High Memory Area instead of the
Conventional Memory.

DEVICE=C:ADOS\HIMEM.SYS
DOS=HIGH

2) A 386 PC with more than 1 MB of memory
Insert the following line on the top of your
CONFIG.SYS file (if you have DOS 5.0 and

" Windows 3.1, type WINDOWS instead of DOS in

the two first lines below to use the newer
HIMEM.SYS and EMM386.EXE from Windows
instead of DOS). )

DEVICE=C:ADOS\HIMEM.SYS
DEVICE=C:\DOS\EMM386.EXE
DOS=UMB

DOS=HIGH

Line 4 will load the COMMAND.COM to the High
Memory Area instead of the Conventional
Memory, and line 2 and 3 will enable you to load
resident programs and drivers into the Upper
Memory Area. Then change ali DEVICE
commands to DEVICEHIGH. in your CONFIG.

High Memory Axe? 1024 Xk 1024 Kb

1) A 286 PC with more than 1 Mb of memory, VP Memoy Ars

SYS file, e.g. DEVICEHIGH=C\DOS\ANSLSYS,
and in the AUTOEXEC.BAT file you can insert
LOADHIGH (or LH) in front of the lines starting
the resident programs, e.g. LH CADOS\KEYR FR.

After you have tuned the memory, rebopt the PC
and type the DOS command MEM to' see the
effect. If you type MEM/C|MORE you will also
see which programs have been moved to Upper
Memory Area, and the message "MS-DOS resident
in High Memory Area” if you have loaded DOS
high with DOS=HIGH in the CONFIG.SYS file.

With a 386 or 486 PC with more than 1 Mb of
memory, you can gain more than 620 Kb free
conventional memory by changing your
CONFIG.SYS and AUTOEXEC.BAT files. For
more information please consult your DOS manual.

Before memory "'tuning" After memory "funing”

1088 Kb

OMMAND.COM
rivers, resident programs (ANSLSYS, KEYB, DOSKEY etc.
S Free Conventional Memory

=

6.DISKETTES WITH CORRECT FORMAT
From time to time we get diskettes from you which
seem to be unreadable. In some cases this is
because the diskettes have an incorrect format.
High Density (HD) diskettes are of a better quality
than Double Density (DD) diskettes, and can
therefore contain more data. Some users still
format DD diskettes as if they were HD diskettes
to be able to store more data, but that is a
dangerous habit. Most PCs will not be able to read
them afterwards, and even worse, there is a good
chance of getting corrupt files on these diskettes.
Below you will find a table showing how to format
the different types of diskettes. If you do not know
what kind of DOS version you are running, type
the DOS command VER to find out. '
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Disk High Density (HD) Double Density (DD)

size

5 1/4" | Capacity 1.2 Mb 360 Kb
Characteristics No ring around the hole Ring around the hole
Command (with DOS 4.0 or higher) | FORMAT A: FORMAT A: /F:360
Command (with DOS 3.3 or lower) | FORMAT A: FORMAT A: /T:40 /N:9

3 1/2" | Capacity 1.44 Mb 720 Kb
Characteristics A hole in upper left corner No hole in upper left corner
Command (with DOS 4.0 or higher) | FORMAT A: FORMAT /F:720
Command {with DOS 3.3 or Jower) | FORMAT A: FORMAT A: /T:80 /N:9

HOW TO HANDLE CURRENCY
POOL LOANS IN THE DMFAS

The purpose of the World Bank’s currency pool is
to equalize among all borrowers at any time the
risks inherent in fluctuations in the exchange rates
of the currencies disbursed and repayable on all
Bank loans included in the currency pool system.
Equalization is achieved by pooling all currencies
disbursed and outstanding on participating loans and

by expressing the outstanding principal amount of

each such loan as a share of the pool. As a result,
debt service obligations on each participating loan
are related to all amounts in the various currencies
disbursed and outstanding on 2all loans in the
system. In practice, only five currencies are used.
Debt service obligations on loans by the Asian
Development Bank and Interamerican Development
Bank are also treated in this manner.

Normally, when entering debt service transactions
into the DMFAS ledger, the amount of the payment
is checked against the estimated amount in the
theoretical schedule. If the amount entered exceeds
the amount scheduled, the corresponding error
message is displayed and data entry is rejected. For
ADB, IBRD and IDB loans in the curency pool
system it is necessary to have the possibility to
exceed the amount scheduled. For these loans, the
client with relation code 20 (= creditor/main
creditor) must be registered on the list of clients
using the currency pool and the repayment
currency code has to be 981.

How to vpdate the list of clients using currency
pool

Select LOAN MONITORING>SYSTEM
ADMINISTRATION>UPDATE REFERENCE
FILES>IDENTIFY CLIENTS USING CURRENCY
POOL

Select function Add

Enter the client number

How to change the repayment currency

Select LOAN MONITORING>DATA
ENTRY>GENERAL INFORMATION>LOAN
CHARACTERISTICS

Change currency of repayment to 981

Select function Change.

TIP OF THE MONTH

The World Bank has a
video which explains
how to work with the
currency pool and with
variable lending rates.
Those interested in
purchasing this video
should contact The World Bank, External Affairs
Department, Film and Video Unit, 1818 H Street,
N.W., Washington, D.C. 20433, USA,




WHAT YOU NEED FOR A SUCCESSFUL INSTALLATION OF A CBDMS

Computer-based debt management systems
(CBDMS) have been in existence for over a decade
now. Experience with the installation and use of
these systems has been mixed. Why?

It is easier to design and implement a CBDMS in
a country where the debt database is not very
complicated. Some counfries have databases
containing many loans subject to some sort of
currency pooling system, e.g. World Bank, Asian
Development Bank. Dealing with these types of
loans is not straightforward. In addition, in some
countries the Government has assumed the debt
from para-statals and the private sector - getting the
necessary data for this subset of the debt has proven
to be very difficult. Further, multiple reschedulings
can cause complications.

An effective debt management system requires well
defined institutional arrangements. These inclnde
adequate legal authority and an appropriate
administrative framework. This will ensure clearly
defined functions and responsibilities. The unit in
which the CBDMS is installed must have the
authority to collect data in a timely and consistent
manner, and the responsibility to disseminate

relevant information to all participants in the debt -

management process. In general, the necessary
structures have not been present in many countries
in which CBDMS have been introduced. It is very
vseful to have the framework established before the
CBDMS is put in place, but this can also be done
during the process of getting a CBPMS up and
running.

Strong commitment from senior officials during and
after installation is another key factor, as is a stable,
well-motivated, and well-trained staff. There has
often been a lot of rotation of staff in the debt
office where a CBDMS has been installed. Many
factors account for this: poor renumeration, no
recognition from senior officials, inadequate office
space, equipment, etc. One of the consequences is
that some of those who have received training on
the CBDMS move on to greener pastures. Some
governments also have a policy of rotating staff on
a routine basis.

The unit in which the CBDMS is installed is also
an important factor, Generally, it is located in 2 unit
in the Ministry of Finance or the Central Bank. In
a country in which the debt is owed mainly by the
Government and/or the parastatals, or even in which
the Government has guaranteed a large proportion

of the debt, the CBDMS can be located in the
Ministry of Finance. Alternatively, in a country
with a large private sector and/or non-government
guaranteed debt, the debt office can be located in
the Central Bank. The decision to locate in one or
the other should also be a function of the purpose
for which the CBDMS is required, the institutional
and administrative arrangements, and the resources
available in the different prospective locations.
Unfortunately, in some situations, the CBDMS has
been installed in locations which do not allow for
maximum benefits to be derived from the system,

Technical support is another important factor.
Generally, advisors assigned to manage the
installations have to be very specialized; he/she
should have in-depth knowledge of the CBDMS as
well as be very familiar with the general practices
and operations of units involved in debt
management, as well as creditor practices.

‘Where the CBDMS is a standard system (designed
centrally and implemented in different countries),
timely and adequate response from the designers in
the event of problems developing or to legitimate
queries or requests is also a significant factor.

There are other factors which affect the effective
installation of a CBIDMS, such as expectations from
the system, adeguate hardware/software
matintenance and security and technical details such
as the setting of a cut-off date. However, a CBDMS
does not equal an efficient debt management. It can

only be one link in an overall system.
This article was contributed by a DMFAS Chief Technical
Adviser working in the field.

Request for information

At the suggestion of debt managers at the workshop
under the African capacity-building initiative held
in Febroary 1993 (see page 2) we think it would be
useful for us to include in the DMFAS Newsletter
a series of articles on the analysis of debt statistics.
We have writien directly to several DMFAS users
involved in such work to ask them to provide
information, and their responses will be included in
future issues. We would also be very pleased to
hear from any other of our readers on this subject.
Topics that seem to be of interest include how debt
data is integrated with foreign exchange
management, and what analysis is of use in policy-
making, etc.




BOOK REVIEWS

World Debt Tables 1992-93

The pattern of external resource flows to developing
countries has changed significantly in recent years,
according to the World Debt Tables 1992-93,
published by the World Bank, Washington, December
1692.

In a pumber of middle-income countries, private
resource flows are playing a much bigger role and
within these flows there has been a shift from debt to
equity financing - comprising foreign direct and
portfolio equity investments ~ and from bank to non-
bank sources. The upturn in private flows is the
primary factor underlying the 130 percent increase
over the past three years in aggregate net resource
flows to middle-income developing countries, to a
projected level of $89 billion in 1992.

In contrast, low-income developing countries - and
particularly those which are severely indebted -
remain heavily dependent on official sources to help
finance their development projects and economic
adjustment efforts. Few of these countries have
benefitted from the recent resurgence of private
capital flows and the overall level of aggregate net
flows to this group of countries is expected to remain
broadly unchanged in 1992 at about $44 biilion.

For the developing countries as a whole, aggregate
net resource flows - comprising debt, equity and
grants - increased in 1992 by 17 percent over the
previous year, to reach $134 billion, with foreign
direct investment and portfolio investment registering
the sharpest increases.

The external debt of all developing countries is
expected to reach $1.7 trillion by the end of 1992, up
nearly $100 billion from a year earlier. During the
year, reduction of debt stocks through debt
restructuring and reduction was more than offset by
substantial new net lending and changes in exchange
rates. However, indebtedness ratios are expected to
remain unchanged as the growth in developing
country exports and output has paralleled the increase
in debt stocks.

Latin America and the Caribbean experienced a
surge in private-source capital inflows in 1992,
stemming from improved economic policies and the
catalytic effects of commercial debt reduction
agresments for many countries in the region.

East Asia and the Pacific continned to enjoy
excellent market access, thanks to high credit-
worthiness, and also attracted increasing foreign
direct investment, signalling investor confidence in
private-sector prospects for Pacific Asia.

South Asia is dependent primarily on official flows,
but there has been some improvement in prospects
for attracting private finances, due in part to
regulatory change.

North Africa and the Middle East is projected to
ses some increase in Tforeign direct investment,
following a stagnation of capital flows in 1991.
Official concessional finance remains an important
component of external financing.

Sub-Saharan Africa continues to rely heavily on
concessional official financing and net flows and net
transfers are very large, relative to GNP,
Nevertheless, for some of the most severely
indebted countries, debt servicing remains
unsustainably high in relation to export earnings and
GNP.

Europe and Central Asia is dominated by
developments in the Former Soviet Union, which is
included for the first time in the aggregate statistics
of World Debt Tables. Due to deferral agreements
reached by the FSU and its creditors on debt
service, net flows and transfers improved
significantly in 1992 for the region as a whole. Net
flows are expected to rise for other countries in the
region, though at a more moderate rate.

While the debt crisis that began ten years ago is
largely over for commercial banks and many
(though not all) of their middle-income borrowers,
the report observes, external viability remains
elusive for many low- and lower-middle income
developing countries, most of whose debt is owed
to official hilateral creditors.
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Although strong official support has provided much
needed cash-flow relief to these countries, additional
debt forgiveness will be necessary for many of them,
if they are to reduce their currently unsustainable debt
burdens.

The report cautions against complacency in the
financing outlook for developing countries, argning
that the access to private flows is still fragile and that
the need to manage them effectively has grown even
greater. "Increased world financial integration implies
low tolerance for misguided policies,” the report
warns, even as it points to a number of differences
which set the current resumption of private capital
flows apart from the period leading up to the debt
crisis.

The most important among them include, in .many
developing countries, policy reforms which have
produced improved fiscal performance, outward trade
orientation and a stronger role for the private sector.
The investor base broadened and assessment of
investment risks has improved through greater
availability of information. All these offer better
opportunities for investment of external resources than
existed in the 1970s or 1980s.

(This articie is adapted from the World Bank’s Press
Release on the World Debt Tables)

The World Debt Tables 1992-93 are available from The World
Bank, 1818 H Street, N.W., Washington, D.C, 20433, U.S.A.

MISSIONS OF DMFAS TEAM MEMBERS
January 1993 - June 1993

Enrique Cosio-Pascal

‘Washington DC, USA (Febrnary), Argentina (March),
New York, USA (June), Bangladesh (June)

Fedra Dell’Aquila

Argentina (March)

Manno Jamsen

Bangladesh (June)

Sarah Ross

‘Washington DC, USA (February), London (February),
New York (June}

Dagfinn Vaksvik

Djibouti (January)

Mark Willis

Bangladesh (June)

Good Debt Management Pays
UNITAR training programmes in the legal aspects
of debt management.

The UNITAR Geneva office has published a
brochure called ‘Debt Management Pays’, which
contains a summary of lectures at the national
awareness seminars for senior officers on
management of external debt held in Dar es Salaam
and Kampala in 1990. The compilation contains
summaries of presentations made by various
UNITAR resource persons having extensive
theoretical and practical experience in the field of
debt management. Topics include External debt,
public finance, and the balance of payments by
Jocelyn Horne, External debt and the development
process by Ishrat Husain, Reguirements for effective
debt management by Nihal Kappagoda, and Legal
aspects of external debt management by Professor
Rolf Knieper,

TUNITAR’s training programme In the field of debt
management seeks to provide training in legal
aspects of debt management in countries of Sub-
Saharan Africa and Asia and the Pacific. A range of
sensitization workshops, sub-regional seminars and
national follow-up workshops have already been
held, and further activities will be continued in the
participating countries to sensitize andfor train
senior officers, middle-level managers, economists,
law professors and lawyers in the legal aspects of
debt management. This programme is implemented
with a view to establishing facilities in selected
countries for providing training on a continuing
basis, nationally and sub-regionally.

Guod Debt Munagement is available from the UNITAR European
Office, Palais des Nations, CH-1211 Geneva 10, Switzerland




THE DMFAS IN TWO COUNTRIES

This article takes a look at the experience of
UNCTAD’s technical assistance in debt management
in two different countries.

In some countries, installing a computerised system is
not the cenfral focus of the technical assistance
provided by UNCTAD. Often, problems that countries
encounter when monitoring their loans stem from
organisational difficulties. Loan contracts are not kept
in one place, institutions do not communicate with
one another, staff is constantly replaced. However,
this was not the case in the biggest DMFAS project
so far, in a country we shall refer to as Atlantis. All
information on external debt was already centralised
in the statistical unit of the Central Bank. But the
number of loans was so large that the information
could not be handled manuvally or with simple
software tools.

When Atlantis approached UNCTAD for help in
recording and monitoring its external debt, the
DMFAS was in its early stages. The project offered
UINCTAD a real opportunity to ses how the system
coped with such a huge loan database. When the
project began, the unit was managing about 5,000
loans which generated over 20,000 schedules. The
DMPFAS version 2 was installed, and the loans
registered. However, due to the size of the database,
it took several days to calculate all the amortization
tables for the loans. The computer had to be left to
calculate undisturbed, and if a power cut happened,
the whole process had to be started again.

The project also turned out to be more complex and
costly than initially anticipated by UNCTAD. Various
bugs and gaps in the software were identified, and
UNCTAD had to resolve these. In addition, Atlantis
had some very specific requirements for reports and
management processes, and these had to be
incorporated into the system. As aresult, a completely
separate “Atlantis’ module was developed. This left
UNCTAD with the dilemma of having two separate
systems. In 1988 it was decided to incorporate the
Atlantis module into the DMFAS, resulting in version
4 of the system. Several members of the DMFAS
team spent most of the summer in Atlantis installing
version 4 and configuring it for the users’ needs, who
were satisfied by the end of the mission that the new
version responded fully to their needs.

Future versions of the system have taken into account
the experience in Atlantis, an experience that was
mirrored in other countries with smaller loan
databases. For example, DMFAS version 4.1 permits

very rapid calculations. Instead of days being
needed to generate amortization tables, one thousand
of these tables, comprising an average of thirty
principal and interest instalments, may be calculated
in approximately three minutes on a 386 computer
running at 33 MHz. (Incidentally, one DMFAS user
was so pleased with the rapidity of version 4 when
he first saw it that he cried: ‘It’s a miracle!’, the
kind of reaction that all of us who work in technical
co-operation appreciate).

Atlantis provides an example of a country’s needs
defining the future development of the technical
assistance offered. It was thanks to Atlantis that the
rescheduling module of the DMFAS was developed,
since, after its first visit to the Paris Club in 1990,
Atlantis had a huge number of reorganised loans
and transactions to register. After the recent Paris
Club rescheduling in 1992 UNCTAD has been
helping Atlantis to register the extremely
complicated agreements that arose from this
rescheduling, an assistance that will also benefit
other countries using the DMFAS.

In the late 1980s UNCTAD and ECLAC
collaborated to provide technical assistance in debt
management to a small group of countries. The
situation in these countries was roughly similar and
it was felt that the most effective way to deliver
agsistance was on a regional basis.

Providencia (as we will call one of the countries in
the region) had no central debt unit in the early
1980s, but it had started developing a computerised
system to manage its external debt. This system
worked in the national currency, and solved some of
the immediate debt management needs. However,
debt got more and more complicated and difficult to
manage. The aim of the regional project, which
started in 1988, was not just to instal the DMFAS
in the five countries, but also to improve the
institutional context in which debt management was
performed. Each country was to set up a national
debt office in the main institution that managed
debt. In Providencia, it was decided to set up the
national debt office in the Ministry of Finance,
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because the details of Ioans and most transactions
were channelled via the Ministry of Finance.

Three training seminars were held under the regional
project. The first, in June 1988, covered mainly
conceptual issues - how to treat loan contracts for
example. Providencia centralised its debt information,
gathered its loan contracts, and prepared for
installation of the DMFAS. Between the next two
training seminars concern arose that using the
DMFAS made Providencia very dependent on
UNCTAD, and UNCTAD was a long way away.
‘What would happen when the regional project ended?
The authorities took a few decisions - they would
continue with the DMEAS, but at the same time they
would continue to develop the national system.

The last training seminar under the regional project
was held in 1991, and the countries were provided
with version 4 of the DMFAS. As in Atlantis, the
great improvements included in this version were a
real response to the countries’ needs and to the
perceived weaknesses- in former versions of the
system.

The next few years saw the DMFAS gradually
establishing itself in Providencia. The main problem
still remained the relative lack of support from
UNCTAD. With no regional project now in place, and
a follow-up project not implemented due to-lack of
funds, UNCTAD was not able to provide the presence
in the region, for technical backstopping or
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As you know, all DMFAS users can ring-or fax the
DMFAS team in Geneva if they have a problem.

THE DMFAS TEAM
All numbers are prefixed by
41 for Switzerland
22 for Geneva

Enrique COSIO-PASCAL
907 5924

Nathalie BOIS

907 6048

Alain BODIN

907 5856

training, that it would have liked to. But, on the
plus side, Providencia went for the first time to the
Paris Club (in 1990) and the DMFAS proved its
worth in providing figures for the Club and for the
bilateral negotiations that followed. Then in 1991/92
the exchange rate was liberalised. The national
system, which worked in the local currency with a
static exchange rate, was not able to cope. The
DMFAS began to play a more important role -
providing information to the parastatals, to the
Central Bank for its reporting to the World Bank’s
Debtor Reporting System, to the IMF. By 1992, it
was clear to the authorities that it was worth paying
for three people to attend the training seminar in
Geneva which coincided with the release of version
4.1Plus of the system.

One of the useful lessons from the experience of
Providencia is that, to sustain momentum after the
end of a project, regional capacity has to be built,
both in system support and training. The person
who was originally trained in the DMFAS under the
regicnal project in Providencia now provides
training to staff in other institutions as well as his
OWIL

In September 1994, under the Joint Programme,
UNCTAD will be releasing version 5 of the
DMFAS, a version that will build not only on the
huge advances made in computer technology, but on
the lessons learnt over the last ten years from
DMFAS users in countries around the world.
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907 5850

Pekka SANKALA

907 5860

Philippe STRAATMAN
907 5845
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907 5859

Dagfinn VAKSVIK
907 6049
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FAX NUMBER: (41 22) 907 0045
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